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1 Installation Guide 

1.1 Pre-installation instructions 

Before the module is uninstalled, changed, or repaired, make sure that config files in the Directory and web 
config file with related message Tracking folder in inetpub are backed up properly. 

 

Figure 1 – Setup WIzard 

 

The Automation Server with all the modules is normally installed through an MSI package. Run the .msi file and 
follow the installation wizard. It can also be directly deployed as a virtual application in IIS using just a zip file 
but then manual steps are required such as adding the license in the registry hive. The following steps are when 
using MSI installation: 

 

Figure 2 – End-User License Agreement 
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1.2 Environmental Configuration 

 

Figure 3 – Environmental Configuration 

When installing the software for the first time, you will need to specify which environment(s) you wish to be 
able to connect to. You do this by clicking the Add new button. When upgrading to a new version, or modifying 
an existing installation, you may choose to retain the current settings and simply click Next or make changes to 
the environment configuration by clicking Modify. 

You will be able to choose between the environments in the AIS login dialog, from any of the supported MS 
Office applications. 

 

1.3 Configuration Settings 

The configuration settings allow you to customize your installation. 
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Figure 4 - Configuration Settings 

Configuration name: Choose a name that describes the configuration (e.g. Race 8 demo), if it should be the 
default logon choice, and whether IFS is configured for single sign-on. 

Server URLs: Select the server URL of your choice 

IFS Version: Choose your IFS version 

If you are not sure what options to check, leave the default values. You can change the values temporarily from 
within the application at any time. 

To add a new environment, you need to specify the address to IFS Extended Server (e.g. server1:58080), the 
Application owner (e.g. IFSAPP) and the IFS portal (e.g. http://race75sp6:58080/). 

 

Figure 5 - Data Access Information 

The Database connection must use the prefix HTTP or HTTPS (in lower-case). 

http://race75sp6:58080/
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Figure 6 - Data Access Information 

 

Figure 7 - Data Access Information 
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1.4 Additional Settings 

In the Additional Settings dialog, you can define a symbol that exclude classes and formats with this particular 
symbol. This field is defaulted to the asterisk symbol.  You can also define the Document Search URL in this 
dialog. 

 

 

Figure 8 – Additional Settings  
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1.5 License Key 

You will have received a license key from Addovation upon purchase of the AIS. Please enter the license key 
during the configuration of the software. 

 

 

Figure 9 - License and custom settings 

In the Help URL field, you can specify what the help symbol in the AIS will point to. Included in the AIS is an 
online user documentation. The link is normally already filled in, so if you don’t want to provide your own 
information, you can leave it as is. 

When you have entered the correct license key, you will receive a validation listing the products and their date 
of expiry. 
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Figure 10 – License key validation  
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1.6 Simple distribution – ‘Get batch’  

The ‘Get batch’ option allows you to install the software on several machines, without having to enter your 
settings multiple times. 

 

Figure 11 – Get Batch 

 

When you click on the button ‘Get Batch’, a .bat file is created, which will launch the .msi using the settings you 
defined in the current installation.   

Observe the following with generating the batch file: 

• The batch file must be executed by a user having administrator rights 

• If you experience problems running from a network drive, try to copy the installation file to a local 
drive 

• The batch file created can only be used to install 32 bit or 64-bit version, depending on the installation 
file.  
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Figure 12 – Save batch file 

A .bat file and a .PS1 file is generated at your chosen location. 

When you want to distribute the software to other computers, download the .msi, the.bat and the .PS1 file to 
the chosen computer. Open the .bat file and right click ‘run as administrator’. The installation file will then run 
with your chosen parameters, installing AIS on the computer. 
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1.7 Automatic installation of scripts – PL*SQL 

If this is the first time you run the AIS installation, you need to run the PL*SQL function. 

 

Figure 13– PL*SQL script 
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Figure 14 – Execute PL*SQL scripts 

Click on the PL*SQL button and type in your username and password (Usually IFSAPP or IFSADM) and the 
environment where you would like to install the scripts.  

If you have scripts saved to your drive, you can browse for these using the ‘browse’ button. Click ‘Execute’ to 
run the scripts and to give the necessary access and grants. The wizard will confirm that the scripts were run 
successfully. You may have to enter parameters for some of the scripts   
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1.8 Customized setup 

Under ‘custom setup’ you can select the way the features are to be installed for the various MS Office 
components. Click on the icons in the tree list to adjust the installation for the components. 

 

 

Figure 15 – Setup Types 
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Figure 16 – Custom Setup 

 

Components 

• IFS to SQL Server Plugin 

• Plugin Executor  

• Document Agent 
Reads files or emails from configured folder or mailbox and does stuff like create work orders or other 
IFS items. 

• Addovation Cloud 

• Addovation Uplink 

• Message Tracking 

• Create Documents  

• M365 CRM Sync 

• Create Document Azure Consumer 

 

Location 
Always try to use default location if possible. It’s easier to find the folders if they are where they should be. 

 

 



  

 

Addovation © 2022 Setup Guide  Page 16(41) 

1.9 Disk Space Requirements 

According to the selected features in the above step, disk space requirement is calculated and displayed in the 
Required Column. You can see this by pressing the Disk Usage. 

 

Figure 17 – Disk Space Requirements  
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Create Documents Service is not be able to install/upgrade without IIS. Setup will exit after giving below 
warning message. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18 - IIS requirement 
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1.10 Ready to Install 

After adjusting the disk space as per the need in your local machine you can complete the installation  

 

Figure 19 - Install 
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1.11 Configure the web service on IIS 

• Once the create document module is installed, ‘CreateDocuments’ folder will be created in the 
‘inetpub’ folder. 

 

Figure 21 - Create Document in ‘inetpub’ Folder 

• IIS configuration to host WCF Service 

Figure 20 - Finish 
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• If the service is installed successfully service can be browsed as depicted below. 

 

Figure 22 -  IIS with installed site 

Figure 23 - Browse service  
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1.12 IFS Applications - IFS integration configuration  

• Web config file should be modified by providing values to point the service to the correct IFS 
Applications instance as depicted below. 

 

 

“ifsAccessProviderUrl” Point to the application server hosting IFS Applications. 

“ifsUser” The integration user used in accessing IFS Applications. The database 
access authorization rights generated under the subheading 
“Generate database access authorization script” should be granted 
to this user. 

“ifsPassword” The password for the “ifsUser”. 

“appowner” The name of the application owner for the IFS Application instance 

“tempFolder” A temporary folder to store temporary files. This location should be 
cleaned regularly. 

“debugFolder” Folder where debug information will be stored 

“isDebugEnabled” has the options Off, Light and Full 

Off – No debug information will be created 

Light – Details related to performance will be generated 

Figure 24 - Create Document Web Config file 
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Full – Details related to performance as well as other information on 
the tasks performed will be stored in order to assist in debugging 

 

“dbLocale” DB local of the database. 

“numberConnections” Number of concurrent connections created to access the database 
for certain activities.  

 

“ifsVersion” The major version of IFS Applications. 

“templateCacheDuration” The duration that the templates will be cached in memory. 

 

1.13 IFS Cloud - IFS integration configuration 

For IFS Cloud, some new web.config parameters has been introduced. In web.config, in order to configure URL 
and integration user, the following keys need to be set: 

 

ifsAccessProviderUrl The URL to the system, normally it is https://someurl.com. 
ifsTokenEndPoint The token end-point that has been configured for the IFS Cloud instance. 
mappingFolder  The folder in where all mapping files are being kept and maintained. 
ifsClientId  As defined in IFS Cloud IAM. 
ifsClientSecret  As defined in IFS Cloud IAM and encrypted using Addovation Encryption. 

The following keys can be omitted when going against an IFS Cloud instance: ifsUser, ifsPassword, appowner. 

Last, we need to tell the service that this is an IFS Cloud instance: 
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Note: Even though the IFS Cloud instance is running IFS Cloud 22R1, “IFSCloud21R2” can and must be used. IFS 
Cloud 21R2 and IFS Cloud 22R1 is using the same authentication flows. 
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1.14 Trigger Service request using WcFTestClient 

• Run WcFTestClient resides in visual studio root folder. 

 

 

 

 

 

 

 

 

 

 

 

• Provide the address of endpoint service 

Figure 25 - WcFTestClient 

Figure 26 - Add service address 
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• Double click on CreateDocumentReport() related to given service 

Figure 24 Add Service to WcFTestClient 

Figure 26 WcFTestClient 

Figure 27 - Service Projects in WcFTestClient 

Figure 28 - Created service 
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• Provide the values for document type and ‘invoke’ the request. 

 

• Result will be displayed with the information of checked-in details. 

 

Figure 29 - Invoke Request 

Figure 30 - Response 
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• Created document revision in IFS Applications. 

 

 

 

  

Figure 31 - Created Document Revision 
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1.15 IFS Applications – Mapping data to templates 

For templates that is used in IFS Applications, Addovation Office Automation Suite is required to create 

templates. Information on how to create these templates exists in the user guide for Office Automation Suite. 

1.16 IFS Cloud – Mapping data to templates 

Mapping data to templates for IFS Cloud is different and does not require Addovation Office Automation Suite 

to be installed. The mapping consists of basically 3 parts: 

• The Microsoft Word document that will be used as a template. 

• EDM basic data in IFS Cloud that defines the document class, format size and language to be used for 
the template. 

• A newly introduced mapping file between the template and data in IFS Cloud. 
o A default mapping file will be generated the first time service is being used and then throw an 

error. 

For IFS Cloud, there are mainly 2 types of data that will be injected into a Word document: 

1. Document properties. 
a. Properties are singular information such as details for a Customer Order. 
b. Properties can be used as variables for quick report tables. 
c. Additional singular document properties can also use quick reports. 

2. Tables. 
a. Tables are multiple rows of information such Customer Order Line. 
b. Data source is quick reports. 

For document properties, all names must be unique and correspond with what IFS Cloud delivers. For tables, 
the content control ID must be unique. 

1.16.1 Mapping file explained 

The newly introduced mapping file(s) is JSON file(s) that maps data between an EDM template and IFS Cloud 
data. Upon first time use of the service, a single default JSON file be generated must be modified using some 
appropriate editor such as notepad++. The location of these folders is being set in the web.config. 

The names of the files does not matter, as long as they end with “.json” and the file can be deserialized into the 
used format. Good practice is to keep 1 file per template: 
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 When it comes to editing these files, it might look like this: 

 

As we can see here, both singular document properties and table information has been mapped into a given 
EDM template. Available variables are being mapped by using the &-character in front of the property name. 
Then they will be replaced in the request. Variables can also be hardcoded here if needed. 

Description  Some simple description to make it easier for maintenance.  
EdmDocumentClass The EDM template document class as defined in IFS Cloud. 
EdmLanguageCode The EDM template language code as defined in IFS Cloud. 
EdmFormat  The EDM template format size as defined in IFS Cloud. 
DocumentProperties Additional quick reports that will fetched as singular document properties. 
Tables    The Microsoft Word content control ID that shall be mapped against a quick report. 

These files (and the template itself) are being cached on the server so it is vital to clear the IIS cache before 
testing any changes in the mapping or the template. Please also note that all information and mapping has to 
be precise (a character wrong will cause failure to merge accurate information). 

1.16.2 Mapping singular document properties – standard 

For singular document properties, there are two types of default entity sets that is being injected into the 
document automatically: 

• All fields from entity set DocIssue. 

• All fields from the current logical unit default entity set. 

DocIssue fields 

What fields that is being returned depends on the customer installation (since it can be configured or 
customized). The RESTful invoke is being done against: DocumentRevisionHandling.svc/DocIssueSet. 

One can use either Postman or IFS API Explorer to see exactly what fields that is being returned in your 
installation / IFS Cloud instance: 
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In order to use any of these fields in a Word template, simply create a new document property for the 
template. It is important though that the name of the property corresponds with what IFS Cloud delivers. 

In order to create a new document property in the template, go to the File tab and Info and then Properties 
and Advanced Properties as following: 

   

In our example, let’s add DocNo so we enter the exact name as a new document property: 
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Add a space or something else as default value (because Microsoft Word has a limitation that requires always a 
value) and then press Add. Now you should have something like this: 

 

In order to use this property now in the document, click OK and head back to Microsoft Word. Go to the Insert 
tab and select Quick Parts and Field as such: 

 

Scroll down to DocProperty field names, select the newly created DocNo as field property and then press OK: 
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Now you should have something like this in the Word template: 

 

By using Alt + F9 one can toggle showing property placeholders on and off in Microsoft Word. Now, last steps 
are to: 

1. Update EDM template in IFS Cloud. 
2. Refresh the application in IIS or simply reset whole IIS. 
3. Test the new template by running the request as explained previously using WCF Test Client. 

Then one should see something like this: 
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Now we see that the document property was injected into the document upon creation in IFS Cloud. 

Dynamic fields from the logical unit 

In addition to DocIssue, fields from the object connection are also being added into the document. The service 
follows same logic as IFS Cloud when it comes to extracting information and fields. The source for information 
in IFS Cloud is DocumentRevisionHandling.svc/$metadata. If the logical unit has been setup properly in object 
connections, there will be something called a dynamic reference in the metadata set: 

 

If we are to connect against e.g. the logical unit OrderQuotation, we can see what fields that will be returned 
from IFS Cloud using Postman: 
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After that, search for “DynLov_<LogicalUnit>” so what we are looking for then is “DynLov_OrderQuotation” in 
this case we have something like this: 

 

Here we see all the additional fields and properties that we can use as variables or directly in our Word 
template. 

1.16.3 Mapping singular document properties – using quick reports 

Sometimes, one needs to have additional document properties. This can be achieved by using quick reports 
with or without input variables. 
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In order to proceed make sure you have a quick report ready and uses any of these input variables and that the 
integration user has access to it. If we want to have this quick report mapped in our Word template, we note 
the projection name, the column name in the quick report result (here we see “SUM”) and the variable name 
(case sensitive): 

 

Make sure also that a Word document property exists in the template with the name “SUM”. 

Next step is to add it to the mapping file. The mapping file exists locally on the server in where the AIS 
CreateDocumentService has been installed as previously explained. RDP to the server and start to edit the 
mapping file. 

Add a new definition as following: 

 

If multiple variables are being used, then use IFS Cloud debug console to see how several variables are being 
set in the request URL. 

After editing has been done, then clear the IIS cache and re-test to see the result. 
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1.16.4 Mapping tables 

Mapping of tables requires usage of rich text content controls in Microsoft Word. Continue by adding a new 
rich text control like so using the Developer tab (it is not enabled by default so one must enable it in Microsoft 
office): 

 

Then it will create a place holder for the table as such, after that click the Properties in order to give it a unique 
name that we will map against a quick report: 

 

In our example, we will call it “LINES_OT” and press OK (it is crucial that we enter the name in the Title field): 
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Next step is to add the table itself within the content control. Click on the Insert tab in Microsoft Word and 
select the number of columns you desire to have and always make it 2 rows (1 row for columns and 1 row for 
the data itself to be repeated in): 

 

In our example, we want to have 5 columns from the quick report – so we simply add 5 columns with 2 rows: 
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Now we add the different column names that will be mapped against the quick report. We will add a display 
value that can be anything and then convert it into a plain text content control that will be used for mapping. 

Continue to add all the display values as following, for instance: 

 

Next step is to select the first header, in this case “Article Number” and convert it into a plain text content 
control: 

 

After that, click on Properties and we will here map it against the column name in the quick report (in our 
example the column name in the quick report is “PART NUMBER”): 
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Next press OK and repeat the process with all column names. Last step we will format the table and make it 
look a bit prettier, for instance: 

 

Now, head to the mapping file and add the newly created content control: 

 



  

 

Addovation © 2022 Setup Guide  Page 40(41) 

Here we enter the word content control and it’s title “LINES_OT” and then what quick report it should be 
mapped against and any eventual parameters and input variables. Save the file on the server and then refresh 
the cache. Check in all appended changes for the EDM template and test the template. If everything was done 
correct you should now see the results as: 

 

In order to delete the content control if no data has been found on need to set the following value in the 
mapping file: 

 

This applies to scenarios in where want to have more dynamic tables. 
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2 Upgrade notes 

2.1 Upgrading old versions to Automation Server 2.1. 33715 or higher from older 

versions. 

While performing an upgrade, environments and license key should be added again, since previously 
configured environments won't be available during and after the upgrade. 


